MS Exchange Update

You may have noticed the addition of an extra several thousand names to the "global list" of your Exchange e-mail. These are the new student accounts we’ve created in preparation for the beginning of fall semester (n.b.: students will not have access to these accounts until the beginning of the semester). Here are some important tips for working with our new, extra-large global list:

- Staff members who take classes will now have two different mailboxes on our Exchange server. One is a staff mailbox; the other is a student mailbox. To send mail to the staff box, select the name in mixed upper- and lower-case letters.

- If you have two mailboxes, you must make sure to check both for e-mail messages! Professors may send class-related mail only to student mailboxes (and others on campus could inadvertently send to your student box). In order to see both mailboxes from your Exchange software, follow these directions:
  1. From within Exchange, select Options from the Tools menu.
  2. Click on the Services tab and highlight “Microsoft Exchange Server.”
  3. Click the Properties button.
  4. Click on the “Advanced” tab.
  5. Next to the box labeled “Open these additional mailboxes,” click the Add button.
  6. Type in the name of your student mailbox ("JONES2," for example) and click OK.
  7. Click OK to close out the two open dialog boxes.
  8. Now you should see your student mailbox listed along with your regular staff mailbox in Exchange.

- Don’t send e-mail messages to everyone on the list. As has been the policy with printed memos, all College-wide communications must be cleared through the Public Relations Office prior to distribution.

- Student mailboxes are listed in all capital letters, which distinguishes them from faculty and staff mailboxes. You can also choose to see only student (or only faculty/staff) recipients. When viewing the address book, click on the “Show Names from the:” drop-down list. “Global Address List” is generally the default selection, which lists students, faculty, and staff alphabetically. If you select “Recipients” from under “Philacol,” you’ll be presented with a list of faculty and staff only. Choose “Recipients” from under “Student” to see the student-only list.

Farewell to Hardy

There will be little mourning over the dismantling of our DEC VAX 8250, the student mail server called Hardy. According to Matt London, director of academic computer centers from 1979-1995, Hardy was first used for internet e-mail for students in 1991. Since then, of course, the speed, size, and power of the server have become obviously inadequate. All students will receive mailboxes on our new Microsoft Exchange e-mail system for this fall term.

Hardy will go off line as of September 12, 1997. Please make sure that any mail or data stored on the machine has been moved before that date. Call the Office of Information Technology at x2645 with any questions.

Important! Any staff or faculty still using Hardy accounts for e-mail must request a move to the new Exchange server. Please call our front desk at x2645 as soon as possible so as not to risk losing e-mail access all together. (Note that accounts on the VAX Laurel will not be affected.)
Infrastructure Update

All of us have seen the work going on around campus, as trenching began in May, followed by the laying of conduit, and now the repairing of lawns. Currently, cables are being pulled through the outdoor conduit and wires run inside campus buildings, terminating in new connections within rooms. Public Relations has published periodic updates to the internal wiring schedule.

The first question is: after the wiring, what comes next?

Remember that this project includes three major components: video, voice, and data. Video cabling and the hook-up to satellite should be complete and functional by the beginning of September. This provides basic cable TV service in residence halls for students, with no monthly fees, close to the beginning of the term. In the near future, we’ll be planning strategies for video capabilities to classrooms as well.

New voice (telephone) lines will be installed in campus buildings also, with the cut-over to the new PBX system planned for the beginning of January. The new phone system will provide voicemail for students, faculty, and staff, plus additional phone line features.

The third component of the infrastructure project is new data wiring which will allow networked computers to transfer data at up to 100Mb per second, giving us a true state-of-the-art network. As the internal data wiring is completed, we will begin to see RJ45 jacks (like larger phone jacks) in our walls. These jacks will provide the link from a computer to the network, but they will not be active at the time of installation.

After the internal wires and data jacks are installed, we still have a big project to actually bring desktop computers up on the new, fast ethernet network. Behind the scenes, this is what’s happening to make the network “live”:

- Fiber is being pulled through the external conduit, so that each networked building is interconnected.
- “Systems rooms” are being built to house the central network hardware and servers, one room in Search Hall, another in Ronson.
- Network “closets” are being built in every networked building, with a patch panel to connect to every internal wire and a network hub to connect to the external fiber. Each data jack that goes live must have a connection made between its location on the patch panel and a port on the hub.

At this point, a data jack would be “live,” which we expect to see start happening this fall, beginning in residence halls. Faculty and staff offices should begin to see some connections come live over the course of this academic year.

Web News

Have you ever been browsing the web and found a hyperlink that claims it will allow you to send e-mail somewhere? These links are quite common, especially at the bottom of a page where many web designers will add a line like: “Click here to send comments.”

If you get an error message when you click, it means that your web browser has not yet been configured to send mail. Follow the simple directions below, or call OIT at x2645 for help.

Internet Explorer (version 3 and above)
If you use Exchange for e-mail, Internet Explorer will automatically invoke your Exchange mail client to send mail from a web page.

Netscape Navigator (version 2 or 3)
1. select “Mail & News Preferences” from the Options menu.
2. click on the Servers tab
3. fill in the Outgoing Mail Server as “park.philacol.edu” (for faculty and staff)
4. leave blank the POP server and POP user ID
5. click the Identity tab
6. fill in your full name and your complete e-mail address (userID@philacol.edu)
7. click OK

The second question is: can my computer connect to this new network?

Only computers identified as “network-compatible” can connect to the new network. Network compatible machines include Win95 systems and PPC Macs with Mac OS 7.5 or higher. To connect to the network, these computers need a special piece of hardware called a fast ethernet Network Interface Card (NIC), specifically, a 3Com “100BaseT” card.

Some new Gateway systems on campus may already have these NICs installed (OIT has supplied only fast ethernet cards since September 1996). Older PCs and all Macs will have either an outdated NIC or no card. The Office of Information Technology will be making recommendations on which NICs to purchase for departmental machines as the schedule for “live” network connections becomes clearer.

Finally, network software on each network-compatible machine must be configured. OIT will schedule “house calls” for departmental machines to install NICs, test connections, and configure software. Students in wired dorms will be expected to have NICs installed by the vendor and will be assisted with software configuration via step-by-step documentation and phone support as needed.
Focus on OIT Staff

Once again we are welcoming a new employee to our staff. Tom Johnson joined us recently as a software support specialist, in which role he supports both Windows and Macintosh computing and contributes to our training and documentation efforts.

Tom comes to Philadelphia College from a similar busy computing support position with the American Philosophical Society. Previously, he worked at the University of Pennsylvania Museum providing network and database support while completing his Master’s degree in American Civilization. Currently, Tom is pursuing a Master of Science in Information Systems degree from Drexel University.

We’re already overworking Tom’s many talents—we feel fortunate to have him in our department! Please join us in welcoming Tom to the College community.

Warning! E-Mail “Privacy”

lease do not use e-mail as a means of communicating personal or confidential information. One common metaphor compares an e-mail message to a postcard… Although it may be addressed to you alone, you cannot be confident that someone else hasn’t seen it along the way. Here are some examples of how this might happen:

1. Internet mail can pass through many, many server computers, not all of which will have top-notch security.
2. Do you ever leave your e-mail program accessible on your office computer? Someone might see your mail inadvertently.
3. If you send or receive e-mail that encounters some kind of transfer or addressing error, that piece of mail will be sent to a system administrator here or at another institution.
4. Is your password easy to guess? Someone else can log onto your email account if he or she can guess it.
5. Some people have a secretary or assistant that handles their e-mail. “For your eyes only” may be overlooked.

In addition to these cases, remember also to be cautious in responding to e-mail. Imagine this (fictional) scenario:

A hard-working professor receives e-mail from her dean, addressed to all faculty in the department. This e-mail strikes the professor as quite humorous, as the dean is proposing a rather Dilbertesque program. The professor forwards this laugh-a-minute idea to a colleague of hers at Penn State, adding a few wry, pithy comments. The next day, the professor comes in to work to discover that she had accidentally used the “group reply” function rather than the “forward” function. Her dean and all her colleagues received the note meant for her friend and now know exactly what she thought of the dean’s idea. Oh, unhappy day!

The moral of the story is: don’t send by e-mail anything that would cause a disaster if posted to the department bulletin board!

Database support

Microsoft Access is the database management software package supported by the Office of Information Technology, with "support" including assistance with installing, upgrading, trouble-shooting operational problems, and limited training in the use of Access database systems, for faculty and staff only. The Office of Information Technology is currently unable to offer database design and development assistance. Some departments hire a temporary consultant who helps determine the data input, retrieval, and reporting requirements of the department and implements an appropriate system using Access software. This consultant should also document the developed system and train staff in its use.

Some departments may wish to identify an existing staff member as a database applications developer. This could be a terrific solution, but be aware that the skills and time required for the design and implementation of relational database systems can be considerable. Staff members could consider taking a College course such as B136, "Database Management," as a good introduction to relational database theory. An alternative might be a 2-day commercial course on "Introduction to Microsoft Access" (available at a discounted price of $376 to College affiliates, from Online Consulting.)

Many database projects might not require the sophistication of multiple data tables (or "relations"). These systems (often called "flat-file databases") can be much simpler to design and implement, although still require some skill with Access development.

The Office of Information Technology is available to work with anybody who is doing database design work for a Philadelphia College department. We could work with a department to help determine the qualifications of an outside consultant and work with designers to help them understand the network, database, and support systems currently in place here at the College.

Summer 1997
Coming Soon: Homepages!

The Office of Information Technology is pleased to announce that in the near future, all College students, faculty and staff will have the opportunity to store personal homepages on our web servers. We hope to be announcing this service by the middle of the fall semester, when additional disk space becomes available on the servers.

Creating and maintaining a web page requires knowledge of web page design, using HTML coding or a web-design tool such as Office 97 or Netscape Navigator Gold. OIT plans to offer web design classes starting in January 1998.

For those members of our community already skilled in web design, watch this space for details on when your web directory will become available!

Software Tips of the Month

In honor of our super summer issue, we’ve decided to include multiple software tips. Enjoy!

Microsoft Excel: Creating a chart

You can display Microsoft Excel data graphically in a “chart.” Charts can take many forms, but are linked to the worksheet data from which they are created and are therefore updated when you change that data.

1. First create the spreadsheet with all the data that you will need for your chart.
2. Select the cells that contain the data that you want to appear in the chart. If you want the column and row labels to appear in the chart, include the cells that contain them in the selection.
3. Now go to the Insert menu, and select “Chart”. The chart wizard will appear and prompt you for details.
4. A few hints: “Category” refers to the text that for the bottom of the chart columns (horizontal, or x-axis). “Value” refers to the text that you want to appear to the left of the chart (vertical, or y-axis). Also, the “legend” can contain key information, as below.

![Weekly Food Expenses chart](Figure A)

Office ’97: Adding comments

Have you ever created a document that you’d like reviewed by others? Ask your team members to review the document electronically by typing comments on a copy of the file that you’ve distributed (possibly via Exchange mail!). Office tracks each reviewer’s comments in a distinct color to help the original author distinguish between different opinions and will number each comment and record it in a separate “comment pane.”

To insert a comment

1. Select the text or item you want to comment on, or click at the end of the text.
2. From the Insert menu, select “Comment.”
3. Type the comment text in the comment pane at the bottom of the screen.

Note: If your computer has a sound card and a microphone, you can even record audio comments!

To edit an existing comment, right-click on the highlighted text and choose “Edit Comments” from the quick menu. To view the text of a comment, simply point at the highlighted text.

Windows ’95: Hiding menu bars

Menu bars, status bars, and taskbars may appear on your Win95 desktop to help you gain quick access to various programs and services. Sometimes you may feel that your desktop is becoming too cluttered! Fortunately, there’s a quick way to hide these tools—“auto hide” reduces the taskbar to a very thin line between uses. To redisplay the taskbar, point to the thin line.

To “auto hide” the Win95 taskbar (with Start menu)

1. Point at a blank spot on the taskbar and right-click.
2. Select Properties from the quick menu.
3. Click the Taskbar Options tab, check the “Auto hide” checkbox, and click OK.

To “auto hide” the Microsoft Office shortcut bar

1. Point at a blank spot on the shortcut bar and right-click.
2. From the quick menu, check “Auto hide” if available. If not, select Customize, click the View tab, check the “Auto Hide between uses” checkbox, and click OK.

INFORMATION TECHNOLOGY MONTHLY

Written and produced for the campus community. Submit comments to it@philacol.edu or call x2645.

Neal Van Eck
Executive Director

Emily L. Corse Lynette C. Lomus
Editor Production & Design